PicoScope® 6
Training Program
CONTENTS

1 Quick guide to PicoScope 6 ........................................................... 1
  1.1 The PicoScope way ................................................................ 1
  1.2 Signal view ......................................................................... 2
  1.3 Timebase ............................................................................ 2
  1.4 Voltage range ....................................................................... 3
  1.5 Coupling ............................................................................... 3
  1.6 Channel selection .............................................................. 4
  1.7 Start and stop capture ......................................................... 4
  1.8 Triggering ........................................................................... 5
    1.8.1 Triggering toolbar ........................................................ 5
  1.9 Saving data .......................................................................... 7
  1.10 Number of samples ........................................................... 8
  1.11 Buffer navigation toolbar ................................................... 8

2 Zooming and scrolling .............................................................. 9
  2.1 Zoom overview and scrolling ............................................. 9
  2.2 Window zoom ...................................................................... 11
  2.3 Zoom in and out .................................................................. 12
  2.4 Horizontal zoom .................................................................. 12
  2.5 Undo zoom and zoom to full view ....................................... 13

3 Measurements ........................................................................ 14
  3.1 Using rulers ......................................................................... 14
    3.1.1 Voltage and time rulers ............................................... 15
    3.1.2 Phase rulers ................................................................... 17
  3.2 Automatic measurements ................................................... 18

4 Channel options ........................................................................ 24
  4.1 Probes ................................................................................ 25
  4.2 Resolution enhancement .................................................... 25
  4.3 Axis scaling ........................................................................ 26
  4.4 Low pass filtering ............................................................... 27
  4.5 Analog options .................................................................... 28

5 File menu ................................................................................. 29
  5.1 Save ................................................................................... 29
  5.2 Save As ............................................................................... 29
  5.3 Startup Settings .................................................................... 30
  5.4 Print and Print Preview ....................................................... 31
  5.5 Recent files .......................................................................... 32

6 Edit menu ................................................................................. 33
  6.1 Copy as image ..................................................................... 34
  6.2 Copy as text ....................................................................... 34
  6.3 Copy Entire Window as Image ............................................. 35
  6.4 Notes .................................................................................. 36

7 Views menu ............................................................................. 37
  7.1 Accessing views menu ....................................................... 37
  7.2 Adding multiple views ....................................................... 38
  7.3 Closing a view ..................................................................... 39
  7.4 Arranging waveforms ......................................................... 40
  7.5 Hiding channels .................................................................. 41

8 Tools menu ............................................................................... 44
8.1 Custom probes ................................................................. 44
  8.1.1 Linear equation ............................................................ 48
  8.1.2 Duplicating and editing a probe ................................. 52
  8.1.3 Look-up table ............................................................. 53
  8.1.4 Importing and exporting a probe ............................... 58
8.2 Math channels ............................................................... 60
8.3 Reference waveforms ..................................................... 61
  8.3.1 Saving and loading ...................................................... 67
8.4 Serial decoding ............................................................. 68
  8.4.1 In graph ................................................................. 69
  8.4.2 In table ................................................................. 70
8.5 Alarms ................................................................. 76
8.6 Mask limit testing .......................................................... 80
   8.6.1 Saving and clearing masks ...................................... 84
9 Help menu ....................................................................... 86
  9.1 User’s Guide ............................................................... 86
  9.2 Online Documentation ................................................ 86
  9.3 Online Forum ............................................................. 86
  9.4 Send Feedback ............................................................ 87
  9.5 Check for Updates ....................................................... 87
  9.6 About PicoScope 6 ....................................................... 87
10 Function generator and arbitrary waveform generator (AWG) .... 88
  10.1 Function generator ....................................................... 88
      10.1.1 Sweep mode ....................................................... 89
  10.2 Arbitrary waveform generator (AWG) ......................... 90
      10.2.1 Importing a waveform ....................................... 90
11 Persistence mode .......................................................... 91
12 Spectrum mode ........................................................... 93
   12.1.1 Voltage range ....................................................... 94
   12.1.2 Frequency range .................................................. 94
   12.1.3 Spectrum options ................................................ 95
13 Advanced custom probes ................................................. 100
14 Advanced views menu .................................................... 110
   14.1 Naming views .......................................................... 110
   14.2 Arranging views ...................................................... 111
   14.3 Custom layout ........................................................ 112
   14.4 Resizing and resetting views ...................................... 113
   14.5 Moving views .......................................................... 113
   14.6 XY mode ................................................................. 114
   14.7 Properties ............................................................... 116
15 Triggering in depth ........................................................ 118
   15.1 Post triggering ........................................................ 118
   15.2 Advanced trigger modes .......................................... 119
      15.2.1 ETS ................................................................. 119
      15.2.2 Rapid block mode .............................................. 120
   15.3 A guide to advanced triggering .................................. 121
      15.3.1 Why do I need advanced triggering? .................. 121
      15.3.2 What advanced trigger types are available? .... 122
      15.3.3 How do I use the advanced trigger types? ....... 126
   15.4 Advanced trigger types ............................................ 127
      15.4.1 Simple edge ....................................................... 127
      15.4.2 Advanced edge ................................................ 128
15.4.3 Window ................................................................. 128
15.4.4 Pulse width ................................................................. 128
15.4.5 Interval .............................................................................. 129
15.4.6 Window pulse width ................................................................. 129
15.4.7 Level dropout .............................................................................. 129
15.4.8 Window dropout ................................................................. 129
15.4.9 Runt trigger .............................................................................. 130
15.4.10 Logic .............................................................................. 131
15.4.11 Digital trigger .............................................................................. 132
16 Advanced math channels ....................................................... 134
16.1.1 Frequency .............................................................................. 140
17 Advanced mask testing .......................................................... 145
17.1 Editing masks .............................................................................. 145
18 Advanced arbitrary waveform generator (AWG) .................. 150
18.1 Using the editor .............................................................................. 152
18.1.1 Importing and exporting from within the editor .............................................................................. 152
18.1.2 Smooth drawing mode .............................................................................. 156
18.1.3 Line drawing mode .............................................................................. 156
18.1.4 Clearing .............................................................................. 156
18.1.5 Undo/Redo .............................................................................. 157
18.1.6 Zoom .............................................................................. 157
18.1.7 Waveform settings .............................................................................. 157
18.1.8 Normalise .............................................................................. 157
18.1.9 Bit stream mode .............................................................................. 158
18.1.10 Number of samples .............................................................................. 159
19 Preferences ............................................................................. 160
19.1 General .............................................................................. 160
19.1.1 Resetting .............................................................................. 160
19.1.2 Waveform buffer .............................................................................. 161
19.1.3 Measurement statistics .............................................................................. 162
19.2 Power management .............................................................................. 162
19.3 Sampling .............................................................................. 163
19.3.1 Adjusting waveform buffers .............................................................................. 163
19.3.2 Slow sampling transition .............................................................................. 163
19.3.3 Slow sampling display .............................................................................. 164
19.3.4 Sin(x)/x interpolation .............................................................................. 164
19.4 Colors .............................................................................. 165
19.5 Keyboard shortcuts .............................................................................. 166
19.5.1 Keyboard maps .............................................................................. 169
19.6 Regional & language .............................................................................. 170
19.7 Options .............................................................................. 171
19.8 Printing .............................................................................. 172
20 The automotive software ....................................................... 174
20.1 Automotive menu .............................................................................. 174
20.2 Waveform library .............................................................................. 176
20.3 Custom probes .............................................................................. 177
20.4 Hidden features .............................................................................. 177
20.5 Rotation rulers .............................................................................. 178
1 Quick guide to PicoScope 6

1.1 The PicoScope way

PicoScope 6 is designed to use as much of the screen as possible to display your signal, while still having the most commonly used functions available at the click of a button.

Traditionally the best way to control a bench-top oscilloscope was with knobs and dials. Since Pico Technology creates PC-based oscilloscopes, there are no hardware controls on the device itself. Everything is controlled by the software instead. Since moving to a PC environment, where the mouse, keyboard and touchscreen are the means of control and capture, the interface has undergone an evolutionary change.

The PicoScope 6 window has three main components:

- Menu bar
- Toolbars
- Signal view

In this chapter the most commonly used features of the Menu bar and toolbars will be explored, to get you up and running as quickly as possible.
1.2 Signal view
The first thing that is visible is the signal view, which is split into a fixed 10 by 10 grid. The 10 vertical divisions represent the voltage range, while the horizontal represent time. The grid is fixed but the voltage and time can be varied.

1.3 Timebase
The timebase can be varied and is set by default to seconds per division. The value goes up in multiples of 1, 2 and 5, for example 1 s/div, 2 s/div, 5 s/div. The minimum timebase varies from product to product depending on the sampling rate of the device, while the maximum timebase for all products is 5000 s/div.

There are lots of timebases, as shown below, which can be accessed by scrolling up and down.
1.4 Voltage range
The voltage ranges are selectable in increments of 1, 2 and 5, e.g. ±100 mV, ±200 mV, ±500 mV, ±1 V.... While the timebase by default is defined as time per division, the voltage range is the full voltage range across all 10 divisions, so a ±20 V range is split into 10 divisions, each 4 V.

In each of these ranges the device maintains its full resolution, so a 12 bit device will use 12 bits in each of those ranges. Choosing the most appropriate voltage range will get the best detail out of a signal. If you use too large a range and zoom in, you will lose detail.

1.5 Coupling
Coupling sets up the input circuitry of the oscilloscope.

There are four kinds of coupling:

- **AC** Rejects frequencies below 1 Hz. Useful for removing DC offset from an AC signal.
- **DC** Accepts all frequencies from DC to the scope’s maximum bandwidth.
- **50 Ω DC** Low-impedance option, available only on PicoScope 6000 Series oscilloscopes.
- **Frequency** Enables built-in hardware frequency counter. Only available on some PicoScope 4000 Series oscilloscopes.
1.6  Channel selection

Multiple channels can be selected. Each one is identified with a different colour and matching axis. For example, on a four-channel scope, the colours are as follows:

<table>
<thead>
<tr>
<th>Colour</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Channel A</td>
</tr>
<tr>
<td>Red</td>
<td>Channel B</td>
</tr>
<tr>
<td>Green</td>
<td>Channel C</td>
</tr>
<tr>
<td>Yellow</td>
<td>Channel D</td>
</tr>
</tbody>
</table>

1.7  Start and stop capture

The red and green buttons in the bottom left-hand corner start and stop the acquisition of data. The space bar on the keyboard can be used as a shortcut to this function. The blue highlight on either the red or the green button indicates whether the scope is capturing. In the image below the green button highlighted as the scope is capturing.
1.8 Triggering

The scope trace is displayed moving from left to right. Without a trigger the signal in question may be missed or signals would not appear to be stable on the screen.

A trigger is a threshold voltage level that, when a signal passes through it, signals the oscilloscope to capture or lock onto the waveform. The image below shows the trigger diamond.

1.8.1 Triggering toolbar

There are five key adjustments to a trigger.

1. Trigger Mode
2. Trigger Source
3. Rising/Falling
4. Trigger Threshold
5. Pre-Trigger

These can be adjusted using the **Trigger** toolbar:
1.8.1.1 Trigger mode

The main modes are

None  No trigger condition is set and PicoScope acquires waveforms repeatedly without waiting for a signal to trigger on.

Auto  PicoScope waits for a trigger event before capturing the data. If, however, no trigger event occurs within a reasonable time, it captures the data anyway and it will keep on doing so until the capture is manually stopped.

Repeat PicoScope waits for a trigger event before capturing the data and will keep on doing so until the capture is manually stopped.

Single PicoScope waits for a trigger event before capturing the data and then once it acquires the waveform it stops capturing.

1.8.1.2 Trigger source

This option defines where the trigger will come from, and will vary across models. One thing that is common across all products is that their input data channels can be used as triggers. Other devices also have dedicated trigger inputs.

1.8.1.3 Rising/Falling

This is the direction to trigger on, so for example a 1 V trigger on a rising edge would only trigger if the signal goes from below 1 V to above 1 V.

1.8.1.4 Trigger threshold

This is the voltage at which the scope triggers.
1.8.1.5 Pre trigger

This is a very useful trigger adjustment as it allows you to see what happened before the trigger diamond. The images below show an injector voltage on a 500 µs/div timebase giving 5 ms across the screen. The first image shows a 22% pre-trigger with 1.1 ms of data before the trigger event. However, looking at the signal you cannot see what happened before this. The second image shows a 50% pre-trigger showing 2.5 ms before the trigger event, which fully shows what the signal does.

These trigger controls can be accessed by either dragging the diamond with the mouse, typing the values in the **Trigger** toolbar, or adjusting them using the **Spin** buttons.

1.9 Saving data

Waveforms can be saved from the **File** menu. A number of formats are available. The psdata format is the PicoScope data format, which saves an exact copy of the waveform.

The psdata format also saves the settings, such as voltage range, timebase, triggering and so on. The pssettings format just saves the settings and not the waveform, which is useful as the file sizes can be much smaller and multiple settings files can be saved for different tests.

A **key benefit** of PicoScope 6 is that the software is licence-free and can be downloaded by anyone with or without a Pico oscilloscope. Thus, saved waveforms can be viewed by anyone in the same detail they were captured in.
1.10 **Number of samples**
This defines the maximum number of samples across the screen: the more samples, the more detailed the signal and the larger the file. The actual number of samples is not always exactly that, but it will not be greater.

1.11 **Buffer navigation toolbar**
Each screen capture is called a buffer in PicoScope 6. More than one buffer can be stored in PicoScope 6 and the **Buffer Navigation** toolbar keeps a count of how many have been captured. The maximum number of buffers is 10 000.

If an interesting waveform appears and then disappears too quickly for you to study it, PicoScope gives you a second chance. You can review past waveforms either by clicking on the double arrows to move backwards and forwards or by opening the **Buffer Overview**, which gives a thumbnail view.
2 Zooming and scrolling

There are a number of ways to zoom into a signal and to scroll through the zoomed waveform. The zoom and scroll facilities are located in the Zooming and Scrolling toolbar, and the horizontal zoom is in the Capture Setup toolbar.

2.1 Zoom overview and scrolling

When the waveform is zoomed in, the Zoom Overview window becomes visible showing the area that has been zoomed in.

This can be adjusted, resized and moved by dragging the corners or moving the box.
Another way to move around a zoomed-in waveform is by using the hand tool, which is operated outside the zoom overview.

This works by dragging the graph around in the main view.
2.2 Window zoom

This allows you to specify an area of interest by drawing a box to be zoomed.
2.3  Zoom in and out

Allows you to zoom in or out around the selected point.

2.4  Horizontal zoom

This allows you to zoom in the horizontal direction by several million times, subject to the capabilities of the device.

The figure below shows a waveform from a PicoScope 6404 zoomed in 100 000 times horizontally.
2.5 Undo zoom and zoom to full view

The **Undo** button to undo any zoom action is located next to the **Zooming and Scrolling** toolbar.

The **Zoom To Full View** button to view the full signal can also be selected from the **Zooming and Scrolling** toolbar.
3 Measurements

Measurements can be made in two ways, by using either rulers or automatic measurements.

3.1 Using rulers

The image below shows the voltage ruler handles and the time ruler handles. The voltage rulers use the same colour as the channel they are associated with, while the time ruler is white.
3.1.1 Voltage and time rulers

There are two rulers for time (or frequency in *Spectrum* mode), two phase rulers, and two rulers per channel for voltage. The rulers can be used by moving the mouse over the ruler handles and dragging. Time and frequency rulers can be moved left or right, and amplitude rulers can be moved up and down.

As soon as the first ruler is dragged, the ruler legend box appears showing the position of the first ruler. Once the second ruler is dragged, the time is added and the difference (delta or Δ) is displayed. For time there is a 1/Δ in the bottom right-hand corner giving the frequency and also an RPM figure.

The more rulers that are added, the more the ruler legend box gets populated. The image below shows an example of a ruler legend box with two time rulers and four voltage rulers across two channels.

The **Lock** button fixes the pair of rulers so that when one ruler is moved its paired ruler moves with it with constant spacing.
In the example above the ruler legend box shows negative numbers. This is because the trigger point is set at 50% pre-trigger and both rulers are positioned to the left of this point.

The rulers are also available in *Spectrum mode*. 
3.1.2 Phase rulers

In the example below, we have dragged the phase ruler handles (in the bottom right corner of the scope view) to the start and end positions on a cyclical waveform. By default, PicoScope labels the two rulers as 0° and 360°, but you can change these values by double-clicking and editing them.

The Rulers button opens the Ruler Settings dialog, as shown below. We have set Phase Partition number to 4, causing PicoScope to draw three additional rulers dividing the waveform into four phases. This feature is useful for identifying features in waveforms from rotating machinery and power semiconductors.
When phase rulers are displayed, try dragging the time rulers onto the display. An additional row appears in the Ruler Legend to show the phase, as well as the time, of the time rulers:

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>Δ</th>
</tr>
</thead>
<tbody>
<tr>
<td>136.7 µs</td>
<td>368.8 µs</td>
<td>231.2 µs</td>
</tr>
<tr>
<td>50.18°</td>
<td>140.6°</td>
<td>90.41°</td>
</tr>
</tbody>
</table>

3.2 Automatic measurements

The automatic measurements can be added from three different areas; from the Menu bar, by right-clicking on the screen, or from the Measurements toolbar at the bottom:
Select **Measurements** from the **Menu** bar, and the **Add Measurements** window will appear. This works similarly in **Scope** and **Spectrum** views:

Click on the first pull-down menu to select the channel from which the measurements are to be taken:

**Spectrum** mode has a similar window:
You can then choose the type of measurement. Those below are specific to Scope mode:

Spectrum mode has its own set of measurements:

Next, select the section of the graph from which the measurements will be taken. In Scope mode it can be across the whole trace, between two rulers, or the cycle around each of the rulers:
In *Spectrum* mode the section of the graph can differ depending on the signal being measured:

![Add Measurement](image1)

or:

![Add Measurement](image2)
The measurements appear at the bottom of the screen. The statistics are taken from the previous 20 captures by default. This number can be adjusted in Preferences. Please refer to that section for more information.

Or in Spectrum mode:
To adjust the font size, go into the **Measurements** menu and select **Grid Font Size**:
4 Channel options

There is a Channel Options button for every channel: A, B, C, D. This includes options for accessing probes, resolution enhancement, scaling, filtering and offset adjustment.

Here are the channel options for channel A on a 3000 Series oscilloscope:

![Channel Options for Channel A on 3000 Series Oscilloscope]

Here is the reduced set of channel options for the PicoScope 2000 Series oscilloscope:

![Reduced Channel Options for PicoScope 2000 Series Oscilloscope]

The options vary from product to product, but all devices allow you to change the probes, resolution and axis scaling.
4.1 Probes
The Probes menu allows you to use a number of built-in probes and any custom probes.

4.2 Resolution enhancement
This is a technique for increasing the effective vertical resolution of the scope at the expense of high-frequency detail. Selecting a resolution enhancement does not change the scope's sampling rate or the number of samples available.

For this technique to work, the signal must contain a very small amount of random noise, but for many practical applications this is generally taken care of by the scope itself and the noise inherent in normal signals.
The images below show detail of a sine wave before and after resolution enhancement to 12.0 bits:

Before: 8.0 bits

After: 12.0 bits

4.3 Axis scaling

This allows you to scale and offset each vertical axis individually. It is particularly useful when multiple waveforms are on the screen. Scaling is done in software.
4.4 Low pass filtering

This feature can reject high frequencies from any selected input channel, and is done in software. This option is available on most devices, but not on the 2000 Series or any data loggers.

The image below shows a square wave before any kind of filtering.
The image below shows a 1 kHz filter on the signal. This rejects the higher frequency components and so in this example the sharp rising edges of the square have been filtered.

4.5 Analog options
These are hardware features that are only available on certain products.

The analog offset is a hardware DC offset that can be adjusted on some scopes. On the PicoScope 6404, it can go up to ±35 V depending on the voltage range.

The bandwidth limiter is a hardware filter whose cut-off frequency depends on the scope series.
5  File menu
The File menu can be accessed from the Menu bar. It allows you to open and view saved and recent files, change start-up settings and print.

5.1 Save
This saves all the waveforms in the buffer with the existing file name. If, for example, a data file was loaded, the Save command will save any updated data and overwrite the same file.

5.2 Save As
This allows you to save the waveform with a different name. It also allows you to save the data in a number of formats:

There is an option to save only the current waveform in the buffer. If, for example, there were 32 buffers and the current view is on buffer 12, saving will save buffer 12 out of 32. You can also save a specified set of waveforms from the buffer.
The following table shows the file formats that can be saved or opened in PicoScope 6:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>psdata</td>
<td>PicoScope 6 format contains full waveform data and settings</td>
</tr>
<tr>
<td>psd</td>
<td>PicoScope 5 format contains full waveform data and settings (this can be</td>
</tr>
<tr>
<td></td>
<td>opened but not saved)</td>
</tr>
<tr>
<td>pssettings</td>
<td>PicoScope 6 format contains settings</td>
</tr>
<tr>
<td>pss</td>
<td>PicoScope 5 format contains settings (this can be opened but not saved)</td>
</tr>
<tr>
<td>csv</td>
<td>Stores up to 1 million samples</td>
</tr>
<tr>
<td>txt</td>
<td>Stores up to 1 million samples</td>
</tr>
<tr>
<td>bmp</td>
<td>Image format</td>
</tr>
<tr>
<td>png</td>
<td>Image format</td>
</tr>
<tr>
<td>gif</td>
<td>Image format</td>
</tr>
<tr>
<td>Animated</td>
<td>Image format over a number of buffers, showing an animation of all the</td>
</tr>
<tr>
<td></td>
<td>buffers in a continuous loop (only available when saving all buffers)</td>
</tr>
<tr>
<td>MATLAB</td>
<td>MATLAB 4 .mat binary format: an open source format with no limitation on</td>
</tr>
<tr>
<td></td>
<td>the number of samples.</td>
</tr>
</tbody>
</table>

5.3 Startup Settings

The startup settings can be changed from the File menu.

This does two things; it saves the current settings as the default startup setting but also assigns them to the Home button and the Load Startup Setting option. Reset Start-up Settings loads the factory default settings.
5.4 Print and Print Preview

The **Print** and **Print Preview** options can also be accessed from the **File** menu.
5.5 Recent files
This shows a list of the most recently viewed waveforms, which appear as thumbnails for quick and easy viewing.
6 Edit menu

The **Edit** menu is located on the **Menu** bar:
6.1 Copy as image
This allows you to copy only the signal view, excluding measurements and the ruler legend box, to the Windows clipboard:

![Signal view](image)

6.2 Copy as text
This copies the raw data in text format to the clipboard. It can copy up to 1 million samples per channel, which can then be pasted into an Excel file.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Time</td>
</tr>
<tr>
<td>2</td>
<td>Channel A</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-2.50087</td>
</tr>
<tr>
<td>5</td>
<td>-2.50055</td>
</tr>
<tr>
<td>6</td>
<td>-2.50023</td>
</tr>
<tr>
<td>7</td>
<td>-2.49991</td>
</tr>
<tr>
<td>8</td>
<td>-2.49959</td>
</tr>
<tr>
<td>9</td>
<td>-2.49927</td>
</tr>
<tr>
<td>10</td>
<td>-2.49885</td>
</tr>
<tr>
<td>11</td>
<td>-2.49833</td>
</tr>
<tr>
<td>12</td>
<td>-2.49831</td>
</tr>
</tbody>
</table>
6.3 Copy Entire Window as Image

This copies the entire PicoScope 6 window to the clipboard:
6.4 Notes
This adds a Notes box at the bottom of the page. The notes are visible when printed and are preserved when the file is saved.
Views menu

The Views menu primarily allows you to split the PicoScope 6 screen into multiple viewports. Each viewport can have a Scope, Spectrum or XY view. The trace that appears in each viewport is called a view.

Multiple views can be placed in one viewport. The example below shows 1 viewport and three views; Scope1, XY 1 and Spectrum 1. These appear as separate tabs.

The Views menu additionally allows you to automatically arrange waveforms, hide/unhide waveforms and look at the Properties window.

The Views menu is accessible in Scope, Spectrum and Persistence modes.
7.1 Accessing views menu

Access the Views menu either via the Menu bar or by right-clicking in the signal view.

At first, the Views menu does not appear to have all the options available, but this is because no views have been added yet. Some features are greyed out when you access the Views menu from the Menu bar, and they are not shown at all if you right-click on the signal view.

Once a view is added, the Views menu in both methods shows and enables all the other options. The first image below shows the Views menu being accessed from the toolbar, while the image on the right is the result of right-clicking.

When right-clicking, two additional commands appear. One is to add a Reference Waveform (see section) and the other is to Add Measurements (see section).
7.2 Adding multiple views
To add multiple views, go to the Views menu, select Add View, and choose a type of view. The view modes available are Scope, Spectrum and XY.

The image below shows 3 additional views being added, each of a different type.
7.3 Closing a view
To close a view, go to the appropriate view and select Close View from the Views menu.

When a view is closed the software automatically rearranges the viewports:
7.4 Arranging waveforms

You can arrange the waveforms in *Scope, Spectrum and Persistence* modes.

When multiple channels are enabled (or reference waveforms and math channels) it can be difficult to distinguish one waveform from another.

Each of the waveforms can be resized and moved up or down. While this is very flexible in certain situations, it can be time-consuming. An alternative is to use the **Auto-arrange axes** command:

To return the layout to default, select **Reset View Layout**.
7.5 Hiding channels

Channels can be hidden or unhiden from view. This is available in Scope and Spectrum modes.

First, left-click on the required viewport to select it. In the example below, the middle viewport is selected.

Next go the Views menu (either from the Menu bar or by right-clicking), select Channels and then click on a channel to disable it.
The tick box next to the channel disappears and the channel is hidden from view.

To re-enable the channel go back into the **Views** menu, select **Channels**, and click on the disabled channel.
8 Tools menu

8.1 Custom probes

PicoScope 6 allows you to adjust the scaling of your input signal using custom probes. There are a number of predefined probes. By default PicoScope 6 has probes set up for x10, x20, and x100. The automotive software has an additional set of predefined probes (please refer to the Automotive section for more information).

To access custom probes, click Channel Options and then click Probe:

Here are the voltage ranges when a x100 probe has been selected:
You also have the flexibility to create your own custom probes with their own units of measurement. You can achieve this using the **Custom Probe** wizard. This can be accessed by selecting **Tools > Custom Probes** from the menu:

Alternatively, you can click **Channel Options** and then the ••• button:

The **Custom Probes** window appears with a list of built-in probes. You can create new probes from scratch, copy and edit existing probes, or import and export probes:
When you click **New Probe**, the **Custom Probe** wizard runs through the steps to create a custom probe. To give an example we will create a DC current clamp that takes 10 mV per amp and can measure a maximum current of 100 A.

Click **Next** to move on to the next window, which allows you to either select standard units from the list or create your own. In this case, amperes can be chosen from the list as it is already defined:
The next step defines the scaling method. Either an equation, or a lookup table, or no scaling can be applied. No scaling is useful if just the units need changing or for limiting the view of a range e.g. showing only positive voltages. More information on this is available in the Advanced section.

Both the linear equation and lookup table methods are covered in this section to highlight the differences.
8.1.1 Linear equation

The image below shows the equation \( y = mx + c \), where \( m \) is the gradient and \( c \) is the offset.

The gradient is the multiplication factor and in this case is 100, since the probe is 10 mV per 1 A.

The offset is used to zero the effects of a DC offset on a signal. In this case it is 0.

The next screen defines how the ranges will be managed. The **Recommended** option lets the software manage these ranges automatically. When **Enable auto-ranging on this probe** is selected, PicoScope continually monitors the input signal and adjusts the range when necessary to allow it to display the signal with maximum resolution. The **Advanced** option allows you to customise the ranges. This is covered in the **Advanced Custom Probes** section. In this example **Recommended** is selected.
The next screen shows the **Filter Method**, which allows you to enable filtering. This is a software feature that applies a low pass filter. Setting the filter frequency only allows frequencies up to this value to be viewed, while any higher frequency components are removed. This is useful for removing high frequency noise or interference on a signal.
The next screen is where you can define the name of the custom probe, with the option to also add extra information:

On the final screen in the Custom Probe wizard, click Finish to confirm your changes. Click Cancel to erase any changes made, or Back to make modifications:
The **Custom Probes** list now shows the newly created probe under the *Library* section:

The newly created probe can now be accessed from the **Channel Options** button under **Probe** on any channel. The probe will appear under *Library*:
Selecting this probe reveals a new set of ranges:

Lots of ranges appear and half of them will be of no use as the probe only goes up to 100 A. Also, the ranges that are useful show negative and positive values, but for a DC current clamp only the positive values are required.

8.1.2 Duplicating and editing a probe
The previous section covered the DC current clamp using the equation method. To highlight the differences we will create another probe. The first probe is duplicated and edited to use a lookup table instead of an equation. To do this, open the Custom Probes window, highlight the newly created probe, and then click Duplicate:
This creates an identical probe with a number (2) at the end of the name to indicate the copy number. To edit the copied probe, highlight it and click **Edit**:

The **Custom Probe** wizard appears with the same options as a newly created probe. The only difference is that the settings for the copied probe will appear.

8.1.3 Look-up table

The image below shows the previously created linear equation.
Select **Use a look-up table** to enable the **Create a Lookup Table...** button:

If you click **Next** without selecting **Create a look-up table...** you will be prompted to do so:

Select **Yes** or **Create a Lookup Table** to open a blank table, allowing you to create a customised lookup table. Click **Import** to save the scaling file as a CSV or text file, or **Export** to export preconfigured CSV or text files:
Alternatively the probe can be defined within the table provided. This can be populated with the raw input readings and then scaled readings as the table below shows. The first things that have to be selected are the units for the Input and Scaled readings. A range of input and scaled units is available:

In the DC current clamp example, the maximum current to be measured is 100 A and at 10 mv/A this equates to 1 V maximum. Therefore the input units are in volts. The scaled units will remain in amperes.

At least 2 pairs are needed to produce a scaling file assuming the relationship is linear. If the relationship is not linear then multiple points are required. In this case it is a linear relationship and 2 points are chosen. The first set of values is 0 V = 0 A and the next will be 1 V = 100 A:
Once the scaling is set, you can adjust the ranges in the **Range Management** screen. As before, the **Recommended** option is selected:

Filtering can also be enabled:
The name and description can now be edited:

Once completed, the modifications made to the probe will appear in the library list:
Accessing the probe from the **Channel Options** button shows the newly added probe in the list:

Select the new probe. The list of ranges now has a maximum current of 100 A and only shows positive values:

8.1.4 Importing and exporting a probe

To save a probe, highlight the required probe and then click **Export**:
The default location is under the **Probes** folder which is located in the **Waveforms** folder under **My Documents**, but the file can be saved anywhere. The file extension of the probe is `.psprobe`:

To import a probe, simply click **Import** and locate the destination folder. Any probes with the `.psprobe` extension will appear in the list:
8.2 Math channels

Math channels are found under the Tools menu:

To select one of the built-in math channels, click the appropriate check box:

Select Invert A and then OK to show both waveforms, as in the image below. The new math channel now has its own axis appearing on the right-hand side:
The math channel is treated like a normal channel. Anything that can be done on a real channel also applies to a Math channel, like measurements and reference waveforms.

8.3 Reference waveforms
A reference waveform creates a copy of an input signal which can be used as a reference point consisting of a known good signal. The incoming signal can be visually checked to see how closely it matches the reference waveform. This is available in both Scope and Spectrum modes.
There are two ways to access reference waveforms. The quick method is to right-click on the screen and select **Reference Waveforms** and the channel. This will immediately create a reference waveform.

The second method is to go to the **Tools** menu and select **Reference Waveforms**.

The next step is to highlight the required channel and then click **Duplicate**:
The reference waveform will appear in a fainter colour in the Library section:

Highlight the reference waveform and select **Edit** to rename it and change the colour:

Once these modifications are done, click **OK**:
To enable the reference waveform, click the check box next to its name:

To see the waveform, click **OK**. The reference waveform will now appear with the defined colour and a new axis:
As the reference waveform created is the same as the incoming signal, it is difficult to see. The image below shows the input signal changed to a sine wave, so the square wave reference waveform is easier to see:

Reference waveforms are most useful on the timebases they were created in. If a longer timebase is selected after a reference waveform is created, the reference waveform will only appear in part of the view, as shown here:
The pre-trigger percentage is also important to consider, as a reference waveform taken at 50% is best suited to a waveform that has also 50% pre-trigger on the same timebase. If you choose the incorrect timebase, part of the reference waveform will be out of sight, as the example below shows.

```
Note: math channels and measurements can be performed on the reference waveform.
```
8.3.1 Saving and loading

Return to Reference Waveforms and click Import and Export to load and save waveforms:

The file extension is .psreference. The default location is in the References folder, which resides in the Waveforms folder under My Documents:

Saved psdata waveforms can be converted to reference waveforms by simply loading the psdata file and doing the same procedure again.
8.4 Serial decoding

The serial data protocols are decoded in software. The protocols available are:

- I²C
- RS232/UART
- SPI
- I²S
- CAN
- LIN
- FlexRay

The data decoded is represented as hexadecimal numbers by default, with data bits, address bits, error bits and parity bits shown separately.

The **Serial Decoding** option can be accessed from the **Tools** menu in **Scope** mode.

Once serial decoding is selected, you are presented with a dialog where the channel and the protocol can be chosen. In the example below, the CAN Low protocol is selected and the threshold and baud rate are set. The **In graph** option displays the decoded data below the actual waveform, while the **In table** option stores all the data on a table.
8.4.1 In graph

The screen below shows the **In graph** data beneath the actual signal and the **In table** data in a table:

Zooming into this signal reveals the frame and field information:
8.4.2  **In table**

Select the **In table** option to display all of the data from the current buffer in a table:

![Table Display](image)

8.4.2.1  **Export**

The **Export** button allows you to export the **In table** data to an Excel worksheet. This will export the channel that has been highlighted. Click **Export** and select the Excel (.xls) format from the **Save As** window:

![Export Button](image)
Here is the Excel file just created with the **In table** data:

![Excel file](image)

8.4.2.2 **Accumulate**

The **In table** serial data that is presented on the screen is only for the current buffer. Click **Accumulate** to keep on adding the new buffer data at the top of the table, while keeping previous buffer data as well.
8.4.2.3 View

The View option allows you to customise what is displayed and how the table is shown on the screen. Frames and fields can be removed from view, as in the example below where only the data frames are selected.

The same can also be done with the actual fields.
The example below shows the removal of a number of fields.

The data is presented in *Hex* by default. It can be changed to *Binary*, *Decimal* or *ASCII*.

An example of a binary display format is shown below.
Font size can also be adjusted. Here is font size 6.5:

and here is size 16:

**8.4.2.4** Link
This drop-down list selects or opens a spreadsheet file that maps numbers to strings.

This button creates a sample spreadsheet file to which you can add your own list of number-string pairs.

**8.4.2.5** Start from filter
Use the **Start from filter** button to enter a condition that PicoScope will wait for before collecting data. When PicoScope detects a packet that matches this condition, it will collect all subsequent data (subject to filtering, if used - see above) and display it in the table.
8.4.2.6 Statistics

Toggle the statistics columns that list measurements such as packet start and end times, and signal voltages.

8.4.2.7 Search

Search for any data value in a specified column of the table.

8.4.2.8 Refresh

Refresh instructs PicoScope to decode the raw data again. This is necessary if the Start from... condition has been changed, for example.

8.4.2.9 Clear

Clear all data and settings in the table. New data will appear the next time that the scope captures a waveform.

For more information please refer to the PicoScope 6 User's Guide.
8.5 Alarms

Alarms are actions that can be programmed to execute when certain events occur.

Events

There are three types of events that can trigger an alarm:

- **Capture** - when the oscilloscope has captured a complete waveform or block of waveforms.
- **Buffers Full** - when the waveform buffer becomes full.
- **Mask(s) Fail** - when a waveform fails a mask limit test.

Actions

PicoScope can execute a number of actions when an event occurs:

- Beep
- Play Sound
- Stop Capture
- Restart Capture
- Run Executable
- Save Current Buffer
- Save All Buffers
- Trigger Signal Generator

Alarms are available in Scope, Persistence and Spectrum modes and are accessed from the Tools menu on the Menu bar.

The default action is to Beep. Click Edit to change the action:
A number of actions are now available:

Select **Save Current Buffer** and choose a file name and location, as in the example below. The default location is the **Waveforms** folder in **My Documents**.
Before the alarm is activated, you must select the tick box to enable it:

Once this has been done the device is ready to start capturing:
To disable the alarm, stop the device from capturing or click **Cancel** each time a waveform is saved. The waveforms are now stored automatically in the specified location, with the number of the capture in brackets. The example opposite shows that 53 waveforms were captured as 53 events occurred.

Add additional events by clicking **Add**:

If, for example, you want the computer or laptop to beep when all the buffers are full, tick the **Buffer Full** event. Each event, when selected, will show its own set of actions in a list, very much like having a new page for every event.
Now when the buffer is full the PC will make a beeping sound. When multiple actions are available under one event, move them up or down the priority list by highlighting the action and clicking **Move Up** or **Move Down**:

8.6 **Mask limit testing**

Mask limit testing is a feature that indicates if a signal goes outside a specified area, called a mask, drawn on the **scope view** or **spectrum view**. PicoScope can draw the mask automatically by tracing a captured signal. Mask limit testing is useful for spotting intermittent errors during debugging, and for finding faulty units during production testing. It is good for doing Pass/Fail tests. Mask testing is available in both **Scope** and **Spectrum** mode.
To create a new mask, select **Masks > Add Mask** from the **Tools** menu.

The next screen that appears is the **Mask Library**. First select the appropriate channel and then click **Generate**:

This will bring up a window where the name of the mask can be defined and how much clearance in the X and Y directions is required by using the up and down arrows or typing in a specific value. The units will vary in **Scope** and **Spectrum** modes:

The adjustments can also be made in % by clicking **SI** and can be changed back to SI units by clicking %.
Once the appropriate offsets are defined, click **Generate**. The mask will appear in the list under **Library**. In **Scope** and **Spectrum** modes the icons will differ:

Highlight the mask and click **Apply** to apply the mask to the view. The image below is of a mask in **Scope** mode:
Click **OK** to display the full mask. The measurements appear at the bottom giving the number of mask failures along with some other statistics. In the example below, 2 waveforms out of 44 have failed.

You can search through the mask failures in the waveform buffer, but this can be difficult if there are a large number of waveforms.
A more useful way to search through these waveforms is to only show mask failures:

Using this method the failed waveforms can be viewed immediately.

8.6.1 Saving and clearing masks
Once you have created a mask it is saved automatically in the PicoScope settings; the next time PicoScope is loaded the mask will appear in the library. Masks can also be saved for use on other machines by going to **Tools > Masks > Save Mask**:
The file format is .mask and by default the location is selected is the Waveforms document under My Documents:

To clear a mask, click on Tools > Masks > Clear Mask:
9 Help menu

Access the Help menu from the Menu bar:

9.1 User’s Guide

The User’s Guide contains detailed instructions on PicoScope:

9.2 Online Documentation

If you have internet access, this takes you to the documentation library on the Pico website.

9.3 Online Forum

This is the discussion forum on our website. Visit regularly to find out about the latest software releases, product announcements, and hints and tips from our technical specialists.
9.4 Send Feedback
If you have comments about PicoScope, please let us know by filling in this form. You can recommend new features that you would like to see, or report bugs or documentation errors.

9.5 Check for Updates
If you have an active internet connection, click **Check for Updates**… to see if you have the latest version of the software. PicoScope regularly checks for updates unless you have disabled the feature in **Tools > Preferences > Updates**.

9.6 About PicoScope 6
Click **About PicoScope 6** to view information about the product and the software currently being used:
10 Function generator and arbitrary waveform generator (AWG)

A function generator has one or more predefined waveforms that can be selected from a list. Many models also have an AWG that allows you to customise and specify the waveform.

10.1 Function generator

To access the function generator from the Scope, Persistence and Spectrum modes, click on the Signal Generator button and then ticking the Signal On box.

From the pull-down menu a number of predefined waveforms can be chosen. This will vary slightly from product to product.
The frequency, amplitude and offset can also be adjusted. Changing the offset to 1 V will move the signal up.

10.1.1 Sweep mode
The signal can be swept by ticking the Enabled box in the Sweep section. You can select the direction of the sweep, the stop frequency, how much the frequency will increment by, and how long between each increment.
10.2 Arbitrary waveform generator (AWG)

For devices that support it, the Arbitrary Waveform Generator allows you to customise your own waveform. This can be achieved in a number of ways.

10.2.1 Importing a waveform

The **Import** button allows you to import a CSV file that contains a set of values between -1 and 1. The example below shows a CSV containing the following points:

1
1
1
1
0.5
0.5
-1
-1
-1
-0.5
-0.5
0

The graph above shows the result of importing the CSV file.

The amplitude, frequency and sweep options can also be altered from the main signal generator controls.
11 Persistence mode

Persistence mode superimposes multiple waveforms on the same view, with more frequent data or newer waveforms drawn in brighter colours than older ones. This is useful for spotting glitches, when detecting a rare fault event hidden in a series of repeated normal events.

The colours indicate the frequency of the data. Red is used for the highest-frequency data, with yellow for intermediate frequencies and blue for the least frequent data.

To access persistence, click the Persistence Mode button on the Capture Setup toolbar.
The **Persistence Options** button gives the full range of controls available:

![Persistence Options](image)

Four modes are available:

![Mode Selection](image)

**Digital Color**
Uses a range of colours to indicate the frequency of waveform data. Red is used for the most frequent data, and less frequent data is represented successively by yellow and blue.

**Analog Intensity**
Uses colour intensity to indicate the age of waveform data. The latest data is drawn at full intensity in the selected color for that channel, with older data being represented by paler shades of the same color.

**Fast**
Uses a simplified drawing method for faster screen updates, of the order of 100 000 waveforms per second with faster scopes. Data hold and line drawing are not available in this mode.

**Advanced**
Opens up a **Custom Options** section at the bottom of the dialog that let you customise the display in **Persistence** mode. For more information please refer to the PicoScope 6 User's Guide, section 7.5.2.
12 Spectrum mode

Spectrum mode plots amplitude on the vertical axis versus frequency on the horizontal axis. The vertical range is measured in dB (decibels) and the horizontal range in Hz (hertz). The Spectrum mode is useful for analysing the frequency components of a signal.

The image below shows a 700 kHz sine wave which should have just one component, but since it is not a perfect sine wave some higher frequency components appear with lower amplitude.

To access Spectrum mode, click the Spectrum Mode button on the Capture Setup toolbar.
12.1.1 Voltage range
In exactly the same way as Scope mode, the voltage ranges are selectable and go up in multiples of 1, 2 and 5, e.g. ±100 mV, ±200 mV, ±500 mV, ±1 V.... While timebase by default is defined in time per division, the voltage range is the full voltage range across all 10 divisions, so a ±20 V range is split into 10 divisions.

The minimum and maximum voltage range varies between products.

In each of these ranges, the device maintains its full resolution, so a 12-bit device will be 12 bits in each of those ranges. Choosing the most appropriate voltage range will give you the best detail out of your signal.

12.1.2 Frequency range
Multiple frequency ranges are available, from a few hertz up to the full bandwidth of the scope.
12.1.3 Spectrum options
This contains controls that determine how PicoScope converts the source waveform in the current scope view to a spectrum view:

12.1.3.1 Spectrum bins
This is the number of frequency bins into which the spectrum is divided. This control sets the maximum number of frequency bins, which the software may or may not be able to provide depending on other settings. The main constraint is that the number of bins cannot greatly exceed half the number of samples in the source waveform. The example below shows a frequency range of 199 kHz and 8192 bins across this range:
If the source waveform contains fewer samples than required (that is, fewer than twice the number of frequency bins), PicoScope zero-pads the waveform up to the next power of two. For example, if the scope view contains 10,000 samples, and you set Spectrum Bins to 16,384, then PicoScope zero-pads the waveform to 16,384 samples, which is the nearest power of two above 10,000. It then uses these 16,384 samples to provide 8,192 frequency bins, not the 16,384 requested.

If the source waveform contains more samples than required, PicoScope uses as many samples as necessary, starting from the beginning of the waveform buffer. For example, if the source waveform contains 100,000 samples and you request 16,384 frequency bins, PicoScope needs only $2 \times 16,384 = 32,768$ samples, so it uses the first 32,768 samples from the waveform buffer and ignores the rest. The amount of data actually used is displayed as the Time Gate setting in the Properties sheet.

12.1.3.2 Window function

A number standard window functions are available.

<table>
<thead>
<tr>
<th>Window</th>
<th>Main peak width (bins @ -3 dB)</th>
<th>Highest side lobe (dB)</th>
<th>Side lobe roll-off (dB/octave)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blackman</td>
<td>1.68</td>
<td>-58</td>
<td>18</td>
<td>Often used for audio work.</td>
</tr>
<tr>
<td>Gaussian</td>
<td>1.33 to 1.79</td>
<td>-42 to -69</td>
<td>6</td>
<td>Gives minimal time and frequency errors.</td>
</tr>
<tr>
<td>Triangular</td>
<td>1.28</td>
<td>-27</td>
<td>12</td>
<td>Also called Bartlett window.</td>
</tr>
<tr>
<td>Hamming</td>
<td>1.30</td>
<td>-41.9</td>
<td>6</td>
<td>Also called Raised sine-squared. Used in speech analysis.</td>
</tr>
<tr>
<td>Hann</td>
<td>1.20 to 1.86</td>
<td>-23 to -47</td>
<td>12 to 30</td>
<td>Also called sine-squared. Used for audio &amp; vibration.</td>
</tr>
<tr>
<td>Flat-top</td>
<td>2.94</td>
<td>-44</td>
<td>6</td>
<td>Negligible pass-band ripple. Used mainly for calibration.</td>
</tr>
<tr>
<td>Rectangular</td>
<td>0.89</td>
<td>-13.2</td>
<td>6</td>
<td>No fading. Maximal sharpness. Used for short transients.</td>
</tr>
</tbody>
</table>

12.1.3.3 Display mode

Three display modes are available; Magnitude, Average or Peak Hold.
**Magnitude**
The spectrum view shows the frequency spectrum of the last waveform captured, whether live or stored in the waveform buffer.

**Average**
The spectrum view shows a rolling average of spectra calculated from all the waveforms in the waveform. This has the effect of reducing the noise visible in the spectrum view. To clear the averaged data, click **Stop** and then **Start**, or change from **Average** mode to **Magnitude** mode. The image below shows the noise floor being averaged.

**Peak Hold**
The spectrum view shows a rolling maximum of the spectra calculated from all the waveforms in the buffer. In this mode, the amplitude of any frequency band in the
spectrum view will either stay the same or increase, but never decrease, over time. To clear the peak hold data, click **Stop** and then **Start**, or change from **Peak Hold** mode to **Magnitude** mode. The image below shows the effects of peak hold on a waveform that is sweeping up and down in frequency from 1 kHz to 100 kHz.

12.1.3.4 **Scale**

This specifies the labelling and scaling of the vertical (signal) axis from these options.

- **Linear**: The vertical axis is scaled in volts.
- **Logarithmic**: The vertical axis is scaled in decibels, referred to the level selected below in the **Logarithmic unit** control.
  - **dBV**: Reference level is 1 volt.
  - **dBu**: Reference level is 1 milliwatt with a load resistance of 600 ohms. This corresponds to a voltage of about 775 mV.
  - **dBm**: Reference level is one milliwatt into the specified load impedance. Enter the load impedance in the box below the **Logarithmic unit** control.
- **Arbitrary dB**: Reference level is an arbitrary voltage, which you can specify in the box below the **Logarithmic unit** control.
12.1.3.5 X Axis

The x axis can be set to either linear or $\log_{10}$:
13 Advanced custom probes

Previously when the *Range Management* section was encountered the automatic settings were chosen. This section covers the manual customisation of probe ranging. To describe how this works a custom probe will be created that only shows positive voltages in ranges from 0 V–1 V to 0 V–20 V.

Going through the process of a custom probe:
The units will be the same since only the negative voltages will be removed from view:

No scaling will be applied:
The advanced range management can now be selected:

The **Manual Ranges Setup** shows a blank canvas:
You can run the **Auto Generate Ranges** process for any product:

Choose the PicoScope 3206B and click **Auto Generate Ranges** to automatically create a list of suitable scaled ranges for each of the hardware ranges. In this example there is no scaling and the full set of hardware ranges is presented:
In this example only voltages greater or equal to 1 V are used. The remaining ranges can be deleted; select a range and click **Delete**:

Once complete, the negative component of each of these ranges can be removed. To modify the existing ranges, select the required range and click **Edit**: 
Double-click ±1 V to bring up the **Edit Range** window. You can use the recommended values or manually adjust the hardware range:

In this case the recommended range is suitable as this will give the greatest voltage and resolution for this range.
To remove the negative component of this range, put 0 as **Min** in the **Scaled range limits**. Once this is selected the range utilisation bar will show that 50% of this range is being used, as below. As this is a software option the hardware resolution will not change:

![Edit Range](image)

The image below shows a more detailed description of the range utilisation bar.

![Range Utilisation Bar](image)

- **Green**: The section of the input range that is used by the scaled range. This should be as large as possible, to maximize the use of the scope's resolution.
- **Blue**: Areas of the input range that are not being used. These indicate wasted resolution.
- **Grey**: Part of the scaled range that is not covered by the input range. This will result in wasted space on the graph. The range utilisation bar may not represent this area accurately when non-linear scaling is being used, so testing the scaled range limits on the scope view is advised.
The **Advanced** tab allows you to invert a waveform, but this is not necessary in this example:

Once completed, the same process can be done for each of the other ranges. The new set of ranges will now be shown from 0 V:
All that is left is to name the sensor and add a short description:

Once completed, the new unipolar Ranges will appear in the Library section of Custom Probes:
The range will now appear in channel options under **Probe**.

Click **Input Range** to see the newly created set of ranges.

The example below shows a signal that is now unipolar on the 0 to 2 V range.
14 Advanced views menu

14.1 Naming views
To modify the view names, go to the Views menu and select Rename View.

The image below shows all four views after they have been renamed.
14.2 Arranging views
To modify the way the views are arranged, go to the Views menu and select Grid Layout. By default this is set to Automatic.

You can choose up to nine viewports, as in the example below, even if some are empty.

The example below shows one viewport, with the additional views appearing as tabs.
14.3 Custom layout
Select **Custom Layout** to define the number of rows and columns.

You can alter this to have three columns instead of three rows:
14.4 Resizing and resetting views
To resize each view, point at the border of the viewport where a double arrow appears (either ↑ or ↓) and drag the window to size.

To undo these size changes, go to the Views menu and select Reset View Sizes.

14.5 Moving views
Move each view between viewports using the Views menu.
After selecting the appropriate view, click **Move View To**. Viewport 3 is chosen in this example.

This will move the view in viewport 1 to viewport 3. A tab will appear at the top of viewport 3 as it now has two views.

You can also choose to simply move views to the next or previous viewports, or drag views around by clicking on the label tab.

### 14.6 XY mode

You can view Lissajous figures in *XY* mode, and plot two channels against each other instead of having voltage versus time. This is particularly useful when looking at phase relationships between channels. It can also be done on math and reference waveforms.

To enable *XY* mode go to the **Views** menu, select **Add View**, and choose *XY* mode. The two most suitable channels will automatically be placed on the X and Y axes. To change the X axis select **Views > X-Axis**.
To access *XY* mode from *Scope* mode, go to the **Views** menu, select **X-Axis**, and change it from **Time** to the appropriate channel.

Due to the number of divisions and the fact that you may be using a wide screen monitor, the shapes may not appear as you would expect. This can be easily rectified by changing the scaling for each channel.
14.7 Properties

Select View Properties from the Views menu.

The Properties window will be shown on the right-hand side, giving you information on the sample interval, sample rate, number of samples used, the signal being generated if using a device equipped with a signal generator, and about each channel. There is also a time stamp which is particularly useful when viewing data at a later date. The Properties window gives the exact time and date the buffer was captured.
Additional information will be shown in *Spectrum* mode, such as the window function used, the number of bins, the bin width, and the time gate. The number of bins defines the frequency resolution, the bin width is the frequency interval for each bin, and the time gate is the reciprocal of the bin width. The example below shows a frequency range of 500 kHz, and the number of bins is 2048. The bin width is calculated by dividing the frequency range by the number of bins, so $500 \, 000/2048 = 244.1 \, \text{Hz}$, and the time gate is $1/244.1 = 4.096 \, \text{ms}$.
15 Triggering in depth

15.1 Post triggering

The post-trigger delay is the time that PicoScope waits after the trigger point before sampling. To enable the post triggering, select the Post Trigger Enable button . When selected, the button will turn blue and the post trigger time controls can now be adjusted .

The image below shows a 1 MHz square wave with the post-trigger delay disabled.

---

The image below shows the post-trigger delay enabled with a delay of 500 ns.

---

The maximum post trigger time varies depending on the product and timebase selected.
15.2 Advanced trigger modes

15.2.1 ETS

Equivalent-time sampling (ETS) allows a digital oscilloscope to capture high-frequency signals with an effective sampling rate much higher than the real-time sampling rate. Most digital storage oscilloscopes (DSOs), including Pico PC oscilloscopes, feature ETS.

ETS constructs a picture of the input signal by accumulating the samples over many wave cycles. As multiple cycles are needed, ETS can only be used to measure signals that are repetitive; single-shot or non-repetitive signals cannot be used.

The figure below shows an 8 MHz sine wave that was captured using a Pico handheld oscilloscope, using a real-time sampling rate of 40 MS/s. The second figure shows the same 8 MHz sine wave sampled using digital ETS. From these waveforms you can see that the real-time sampling gives a wave shape so distorted as to be nearly useless, while ETS gives a much more accurate representation of the input signal.

On repetitive waveforms, a Pico oscilloscope with ETS can provide the same accuracy as more expensive oscilloscopes with higher real-time sampling rates.
15.2.2 Rapid block mode

Rapid block mode reduces the time delay between waveform buffers from milliseconds to as little as 1 microsecond (device-dependent). This is a hardware feature and is available on most current Pico USB oscilloscopes (excluding the PicoScope 2000 Series).

The way the data is captured changes to achieve this reduction in time delay. In Normal block mode, the device captures data in the memory of the device and then transfers it to the PC. After each buffer the device then re-arms itself for another capture. In Rapid block mode, the data is not transferred to the PC after each buffer is captured, but instead the next buffer is captured. This is repeated until the desired number of captures is reached, and only then is the data transferred to the PC.

The number of buffers can be controlled using the Rapid Captures (hare) control. The maximum number is set in PicoScope 6 to 10,000. The actual number that is achievable will depend on the number of samples per buffer and the buffer memory of a device. Rapid triggering is only available on quicker timebases.
15.3 A guide to advanced triggering

Advanced trigger types enable you to capture a stable waveform even with complex signals. Oscilloscopes capable of advanced triggering are ideal for troubleshooting glitches, timing violations, overvoltages and dropouts in analog and digital circuits.

In this guide to advanced triggering we will review basic edge-triggering and its limitations, and then we will explore the possibilities that advanced triggering offers. Finally we will explain in detail how to set up advanced triggers in PicoScope 6.

15.3.1 Why do I need advanced triggering?

As a scope user, you will be familiar with the standard type of triggering used on oscilloscopes. It is called edge-triggering, and on simple scopes it is the only type available. A trigger circuit monitors the incoming signal and waits for the voltage to rise above (or fall below) a set threshold, then causes the scope to capture and display the waveform. This method is adequate when the signal consists of pulses or cycles that are all similar to one another, as they are in a pure sine or square wave. Basic edge-triggering is enabled by default when you start PicoScope 6.

In the first image opposite, the trigger point is shown by the diamond shape. The threshold is set to 0.0 V, and the scope starts to capture as soon as the signal rises above this voltage. This method gives a stable display if all the pulses are of the same shape and equally spaced.

This square wave represents only one type of signal found in electronic circuits. Most signals are more complex than this, as in the more realistic example in the second image.

In this waveform, the pulses are of unequal widths. If you use a simple edge trigger in single trigger mode, the scope will pick the first rising edge it sees. The rising edge of the shortest pulse was luckily caught in this case, but the scope could just as easily have started capturing on any of the other rising edges. If you were looking for a narrow pulse
that only occurred once in every million normal pulses, you would be very lucky to find it using this hit-and-miss method.

In *auto* or *repeat trigger* mode, the scope will continue to capture many times each second. The third image shows a number of waveforms superimposed, as you might see if the refresh rate is fast enough. This type of display is of little use if we want to see the data contained in the pulse train.

This brief view of edge-triggering shows that if you want to reliably find a rare event, such as a narrow pulse buried within a string of wider pulses, you need a more powerful type of trigger.

15.3.2 What advanced trigger types are available?

15.3.2.1 Advanced edge trigger

The advanced edge trigger provides the standard rising and falling edge conditions, and an additional condition called dual-edge triggering. This triggers on both edges, allowing you to check the widths and voltages of positive and negative pulses as the same time, as in the image above. It is useful for rapidly spotting jitter and noise problems.

The advanced trigger types also include *hysteresis* to reduce false triggering on noisy signals. When *hysteresis* is enabled, a second trigger threshold voltage is used in addition to the main threshold. The trigger fires only when the signal crosses the two thresholds in the correct order. The first threshold arms the trigger, and the second causes it to fire. The following example illustrates how this works.

Consider the very noisy signal on the right. It is difficult to trigger reliably on this signal with a normal rising edge trigger because it crosses the trigger threshold, the red line in this example, several times in one cycle. If we zoom in on the highlighted parts of the signal, we will see how hysteresis can help.

In these zoomed-in views, the original threshold is the lower red line. The upper red line is the second threshold used by the hysteresis trigger.
The signal rises across the lower threshold at (1) and (2), arming the trigger but not firing it. At (3) the signal finally crosses the upper threshold, firing the trigger. On the falling edge of the signal, at (4) and (5), rising edges of noise pulses cause the signal to cross the upper and lower thresholds, but in the wrong order, so the trigger is not armed and does not fire. Thus the trigger occurs at only one well-defined point in the cycle, despite the noise on the signal.

**15.3.2.2 Window trigger**

The window trigger detects the moment when the waveform enters or leaves a voltage range. This allows you to search for overvoltages and undervoltages at the same time. In the image above, a 5 volt power supply is monitored with thresholds of 4.5 and 5.5 volts. The window trigger would detect both the positive and negative excursions outside this range.

**15.3.2.3 Pulse width trigger**

Pulse-width triggering enables you to trigger exclusively on pulses of a specified width. This can be useful for finding rare events in synchronous control signals such as write-enables, or for finding extreme values in pulse-width modulated signals.

In the image above, the trigger was set to **pulse width, positive, greater than 70 ns**. This found a 100 ns pulse in a stream of 50 ns pulses.
15.3.2.4 Interval trigger

The interval trigger helps you find missing or mistimed edges. The image above shows two examples of a 4 MHz clock waveform with a missing pulse. You could use a pulse width trigger to search for the extended high pulse in the top example or the extended low pulse in the bottom example, but the interval trigger lets you find both errors without having to change the trigger type. Setting an interval trigger of *rising, greater than 300 ns* will detect both cases. The trigger point is set to the first rising edge after the long interval.

15.3.2.5 Window pulse width trigger

The windowed dwell trigger is a combination of the window trigger and the pulse width trigger. It detects when the signal enters or leaves a voltage range for a specified period of time. In the image above, a nominally ±700 mV signal has occasional overvoltages and undervoltages, but we have set the dwell time to *greater than 100 ns* so that only abnormally wide pulses that go outside this range are detected.

15.3.2.6 Level dropout trigger

The level dropout trigger detects an edge followed by a specified time with no edges. This is useful for triggering on the end of a pulse train. The image above shows the end of a pulse train in which rising edges regularly occur every 133 ns. The dropout trigger has detected that no rising edges have occurred within 500 ns.
15.3.2.7 Window dropout trigger

The window dropout trigger is a combination of the window trigger and the dropout trigger. It detects when the signal enters a specified voltage range and stays there for a specified time. This is useful for detecting when a signal gets stuck at a particular voltage. In the image above, the window dropout trigger was set to a 300 ns delay with a 600 mV to 800 mV window. It ignored the first pulse, which entered the window briefly, and the first dropout, when the signal remained below the window, but detected when the signal remained within the window for more than 300 ns.

15.3.2.8 Runt trigger

This trigger detects a pulse that crosses the first threshold and then returns below it without crossing the second threshold. Pulses like this can cause problems in logic circuits if they violate the receiver’s minimum high level specification.

15.3.2.9 Logic trigger

The logic trigger can detect a number of logical combinations of the scope’s four inputs; A, B, Ext and AuxIO. The conditions that can be applied to each input vary. A and B can be level-qualified or window-qualified, whereas Ext is level-qualified with a variable threshold, and AuxIO is level-qualified with a fixed TTL threshold. In the image above the trigger was set to Channel A, level, above 0 V, Channel B, level, below 0 V, AND. The trigger condition became true in the middle of the trace, at time = 0, when Channel A was above 0 V at the same time that Channel B was below 0 V.

Instead of the AND function, you can choose to combine the channels with other logic functions such as OR, NOR, XOR and XNOR.
How do I use the advanced trigger types?

PicoScope 6 lets you avoid the complexity of advanced triggers unless you really need to use them. We will first look at the trigger mode control and the simple edge trigger types, before moving on to advanced triggers.

15.3.3.1 Trigger mode control

The trigger mode control specifies whether the scope waits for a trigger condition, and if so, how it behaves afterwards. None and ETS modes are not compatible with advanced trigger types. If you select one of these, the Advanced Triggers button will not be available. Single, Repeat and Auto modes work as in any other oscilloscope. They instruct the scope to trigger on the conditions you have set, whether these are simple edge triggers or advanced triggers. You can find a full description of these trigger modes in the PicoScope 6 User’s Guide.

15.3.3.2 Standard triggering controls

The Channel, Rising edge, Falling edge and Threshold controls allow you to set up simple edge-triggering without having to open the advanced triggers dialog. If you are an experienced scope user you will find these controls familiar, even if you have not used PicoScope before. Full details can be found in the User’s Guide. The corresponding controls for advanced trigger types are found in the Advanced Triggers dialog, which we will come to soon.

15.3.3.3 Advanced triggers button

The Advanced Triggers button is the key control that lets you set up the conditions for advanced triggering.

Click this button to open the Advanced Triggers dialog. If the button is greyed out, then you are using a trigger mode that is not compatible with advanced triggering. Change the trigger mode to Auto, Repeat or Single.
15.3.3.4 Advanced triggers dialog

This dialog appears when you click the Advanced Triggers button in the Triggering toolbar. It allows you to set up the simple edge trigger as well as all the advanced types:

![Advanced Triggers dialog]

15.3.3.5 The trigger types list

Select one of trigger types in this list to show a number of options, a diagram and a description on the right of the Advanced Triggers dialog.

15.3.3.6 The advanced trigger options

The options on the right-hand side of the dialog vary according to the trigger type selected from the list. In the following section it is explained which options apply to which trigger types. To save space, the appearance of the dialog for every possible trigger type and combination of options is not shown.

15.4 Advanced trigger types

15.4.1 Simple edge

This trigger type is equivalent to using the basic trigger settings on the Triggering toolbar, as described earlier. The simple edge trigger can be used in conjunction with any trigger mode, including None and ETS.

The source control lets you select which signal the scope should use as the trigger. Set it to either A, B, Ext or AuxIO. These names correspond to the BNC input connectors on the scope device. A and B are the main measurement channels, and have variable thresholds and voltage windows. Ext is the external trigger input, which has a single variable threshold. AuxIO is the auxiliary input on the back of the scope, and has a fixed TTL threshold voltage.

The Direction control specifies the edge that will activate the trigger, and is equivalent to the Rising edge and Falling edge buttons on the Triggering toolbar.

The Threshold control sets the voltage at which the trigger operates.
15.4.2 Advanced edge

This trigger type includes the standard rising and falling edge triggers, but also includes the rising or falling edge trigger that was mentioned earlier in this article. The edge type is selected by the Direction control. The Hysteresis control sets the distance between the two trigger thresholds to improve noise rejection.

The other controls are the same as those for the simple edge trigger.

This and all the following trigger types are not compatible with ETS mode.

15.4.3 Window

This trigger type detects a signal entering or exiting a range of voltages, called the window.

The Direction control specifies whether the trigger operates when the signal enters the window, exits it, or both.

The Threshold 1 and Threshold 2 controls define the upper and lower limits of the voltage window that activates the trigger. You can enter the upper and lower thresholds in either order in the two boxes, and PicoScope 6 will work out which one is the lower threshold and which one is the upper.

15.4.4 Pulse width

This trigger type detects pulses within a specified range of widths.

The Pulse direction control specifies whether you want to trigger on either positive or negative pulses.

The Threshold control operates as for the simple edge trigger type.

The Condition control specifies whether you are looking for pulses wider or narrower than a specified width. You can also specify two pulse widths and trigger on pulses whose widths are either inside or outside those two values.

- **Greater than** triggers on pulses wider than the specified time.
- **Less than** triggers on pulses which are narrower than the specified time. This is useful for finding glitches.

The Time control specifies the pulse width for the Greater than and Less than conditions.

- **Inside time range** triggers on pulses that are wider than Time 1 but no wider than Time 2. This is useful for finding pulses that meet maximum and minimum width specifications.
- **Outside time range** does the opposite; it triggers on pulses that are either narrower than Time 1 or wider than Time 2. This is useful for finding pulses that violate a width specification.

The Time 1 and Time 2 controls specify the minimum and maximum pulse widths for the Inside time range and Outside time range trigger types.
15.4.5 Interval

This mode lets you search for two successive edges of the same polarity that are separated by a specified interval of time.

The **Source** and **Threshold** controls operate as for the **Simple Edge** trigger type.

Set the **Starting edge** control to either *rising* or *falling* according to the polarity of the edges you are interested in.

Next, set the **Condition** control to one of these options:

- **Greater than** triggers when the second edge occurs later than **Time** after the first edge. This is useful for detecting missing events or interruptions in a clock waveform.
- **Less than** triggers when the second edge occurs earlier than **Time** after the first edge. This is useful for detecting timing violations and spurious edges.
- **Inside time range** triggers when the second edge is later than **Time 1** after the first edge and earlier than **Time 2**. This is useful for finding edges within a narrow timing range.
- **Outside time range** triggers when the second edge is earlier than **Time 1** after the first edge or later than **Time 2**. This is useful for finding spurious edges that fail to meet the timing specification.

Finally, set up **Time** (or **Time 1** and **Time 2**) to define the time interval or range of time intervals.

15.4.6 Window pulse width

This trigger type is a combination of the window trigger and the pulse width trigger. It detects when the signal enters a voltage window for a specified time or range of times.

The **Source** control operates as for the simple edge trigger type.

The **Dwell Location** control specifies whether the signal needs to dwell inside or dwell outside the window for the specified time.

The **Time**, **Time 1** and **Time 2** controls operate as for the **Pulse Width** trigger type.

The **Threshold 1** and **Threshold 2** controls operate as for the **Window** trigger type.

15.4.7 Level dropout

This trigger type is activated when the signal remains on one side of a threshold voltage for a specified period of time.

The **Source** and **Threshold** controls operate as for the simple edge trigger type.

The **Dropout** control specifies whether to trigger when the signal remains **High** or **Low**, or in **Either** state relative to the threshold.

The **Time** control specifies the time to wait after the last detected edge before triggering.
15.4.8  Window dropout

This trigger type is a combination of the Level dropout trigger and the Window trigger. It is activated when the signal remains inside or outside a voltage window for a specified period of time.

The Source, Threshold 1 and Threshold 2 controls operate as for the Window trigger type.

The Dropout and Time controls operate as for the Level dropout trigger type.

15.4.9  Runt trigger

As mentioned before, the above article was written after the 5000 Series oscilloscope was released and so does not cover the Runt trigger mode. A runt trigger has two adjustable threshold levels with hysteresis, and detects pulses that are either too low or too high depending on the pulse direction.

With a positive pulse, if a signal rises past threshold 2 and then falls past the same threshold without going through threshold 1, the trigger will be activated. The image below shows an example of a setup for runt trigger settings to capture a runt signal.

The example below shows a positive pulse being captured by the runt trigger. The signal enters threshold 2 on a rising edge, never goes through threshold 1 and leaves threshold 2 on a negative edge. The opposite is true for a runt trigger on negative pulse.
In summary, a runt trigger on a positive pulse will trigger the signal on a negative edge, while a runt trigger on a negative pulse will trigger the signal on a positive edge.

15.4.10 Logic

This trigger type monitors all four scope inputs, A, B, Ext and AuxIO. At the same time it compares each one to its own threshold or voltage window, and activates when some combination of the inputs meet their respective conditions. This trigger type does not support edge-triggering. All channels are either level-qualified or window-qualified, so the trigger does not wait for an edge but operates as soon as it sees a valid voltage.

**Channel A or B setup for logic trigger**

The Channel A and Channel B settings have the most options. Each one has a dialog to select either level-qualified or window-qualified operation.

- With level-qualification selected, the channel is active when above or below the threshold. The Direction and Threshold controls operate as for the Simple Edge trigger type.
• With window-qualification selected, the channel is active when inside or outside the specified voltage window. The Direction, Threshold 1 and Threshold 2 controls operate as for the Window trigger type.

The Ext and AuxIO settings controls have only the level-qualified options.

Each channel has a Use checkbox to the right of its settings control. Setting this box causes the channel to be included in the logic trigger, and clearing it causes the channel to be ignored.

The Logic control specifies how the four inputs are combined to produce a trigger condition. The six most common Boolean functions are provided: AND, NAND, OR, NOR, XOR and XNOR. For example, to trigger when all of the channel conditions are being met choose AND, or to trigger on none of them being met select NOR.

15.4.11 Digital trigger

PicoScope provides a further advanced trigger type for mixed-signal oscilloscopes (MSOs). The digital trigger detects a combination of edges and states on the digital inputs of the MSO. The Digital trigger dialog gives two options for setting up the trigger: a set of buttons for selecting levels and edges, and a text box for specifying the entire pattern in one string of characters:

The button area has a row for each enabled digital input:
You can select each input to be either high or low. If neither level button is pressed, the input level will be ignored.

You can optionally select one of the digital inputs to be edge-sensitive using the rising edge and falling edge buttons. Only one input can be made edge-sensitive.

If you prefer to use the text entry box, the following text string will have the same effect:

```
Binary  F00001111XXXXXX
         D15     D0
```

The text string consists of the following codes, one for each input:

- **F** – falling edge (on no more than one input)
- **R** – rising edge (on no more than one input)
- **0** – low level
- **1** – high level
- **X** – don’t care
16 Advanced math channels

This feature can be found by going into **Tools > Math Channels**: 

Click **Create** and the **Math Channel** wizard will appear:
Click **Next** to enter basic equations:

Click **Advanced** to reveal further buttons. Here is the default set of advanced buttons (under the **Main** heading):
The min, max, \( \bar{x} \) (average) and peak (also known as envelope) are grouped in the **Buffered** section because they can work on multiple waveforms in the buffer. Here, \( \bar{x} \) is chosen on channel A:

After clicking **Next**, the channel name and colour can be defined:
To define the units and ranges, click Next. The range can be left as automatic, or you can select the Override box to customise it:

The next screen summarises the actions taken. Select the Finish button here to save the settings:
When finished, the newly created **Math** channel appears in the **Library**:

Click the tick box and select **OK** to enable the newly created channel:
The signal below shows a very noisy sine wave. Averaging the signal over a number of buffers cleans up the signal dramatically.

The image below shows the peak (also called envelope) taken from a signal that is sweeping up and down in frequency. This takes the min and max pairs and draws a line between them.
The peak measurement is the same as drawing a line between the min and max measurements. The image below illustrates this more clearly. This mode is useful for analysing jitter on a signal.

16.1.1 Frequency

The frequency measurement is useful for detecting anomalies in a signal. The example below is of a crank sensor in a car on a long timebase of 1 s/div.
Applying a frequency to the math channel:

You can now choose an automatic range or manually enter a range:
Choosing the automatic range and then enabling the math channel seems to have no effect apart from creating a new axis on the right-hand side. This is because the automatic frequency range when selected defaults to a much higher frequency and so any low frequencies are invisible.

Going back to the math channel and editing the ranges to be manually configured, and then setting the upper limit to 5000 Hz like in the image below, results in a much clearer image of the frequency changes across the time axis:
Zoom can be used for a closer look at areas where frequency is changing.
The result shows a more detailed view of the signal where the missing tooth on a crank sensor is detected.

Missing tooth indicates a change in frequency
17 Advanced mask testing

17.1 Editing masks

Once a mask has been created it can be modified, and polygons can be added or removed. Right-click on the screen to access the Views menu and select Edit Mask.

A table and a number of points now become available. The table represents the points of the polygon giving their X and Y coordinates.
Each of the points in the polygon can be dragged.

Alternatively a whole polygon can be removed.
A new polygon can also be added.

Once the polygon is added it can be moved around. The various points can be adjusted either by using the mouse to add points or by using the table provided.
Once the mask modifications are complete, select **Exit Mask Edit** in the **Views** menu.
To save a mask, right-click on the screen to open the **Views** menu and select **Mask > Save Mask**.
Advanced arbitrary waveform generator (AWG)

Changing the frequency of an AWG signal is different to changing the frequency of a standard signal. The standard signal generator frequency represents one cycle from a waveform, while an AWG waveform can contain multiple cycles.

The example below shows a 1 kHz sine wave created from the standard signal generator.

Accessing the AWG and creating a sine wave with 5 cycles.
Applying this will produce a 5 kHz sine wave, even though the frequency is set at 1 kHz.
18.1 Using the editor

The arbitrary waveform editor allows a greater degree of flexibility in creating a custom waveform. With the AWG the minimum values are defined between –1 and +1. These have no units, so the actual output level will depend on what amplitude has been selected in the software. For example, 1 V amplitude will give ±1 V, and 2 V amplitude will give ±2 V. The amplitude is adjusted in the main signal generator controls.

18.1.1 Importing and exporting from within the editor

The editor includes some additional import and export functions.

- Export as CSV
  Save the AWG waveform as a CSV file and use it later or with PicoScope

- Import from a channel
  Import data from a channel displayed in the PicoScope

- Import from CSV
  Load a CSV file with the waveform data
Importing from a channel is a particularly useful feature that allows captured waveforms to be imported into the editor. The example below shows a crank sensor signal. The area between the rulers is the area of interest as it shows one complete cycle of the crankshaft.

Go into the editor and select the **Import From Channel** button to show a number of options, such as which channel and section of the waveform channel are be imported:
Two options are available between samples or between time rulers. In this example time rulers are required:

Click **OK** to show the imported data from channel A between the two rulers:
The waveform can now be applied. The image below shows the waveform at a much higher frequency and a lower voltage than the original:

This can be altered by going into the main **Signal Generator** controls and dropping the frequency to a more appropriate number, then increasing the voltage level.
18.1.2 Smooth drawing mode

Using the drawing icons, a waveform can be drawn. The *Smooth drawing* mode acts like a paintbrush.

18.1.3 Line drawing mode

The *Line drawing* mode draws straight lines.

18.1.4 Clearing

The *Clear All* button clears the screen and leaves a line going through zero.
18.1.5 Undo/Redo

The waveform editor keeps track of any adjustments made to a waveform. If a mistake is made, the Undo button can go back to the first step taken. This does not include zooming as this has separate controls, but every other operation can be undone. If the Undo button is pressed by mistake, the Redo button can go forward one step at a time, all the way to the latest modification made.

18.1.6 Zoom

The Zoom buttons zoom horizontally in or out around a chosen point. The Zoom To Full View button cancels all zoom and displays the whole waveform.

18.1.7 Waveform settings

A number of predefined shapes can be selected. The number of cycles can be adjusted, the minimum and maximum values can be adjusted, and the duty cycle can be varied.

For example, the image below is produced by a square wave that has 10 cycles, with the minimum amplitude set to 0 and the max set at 0.9, with a duty cycle of 75%.

18.1.8 Normalise

The Normalise button expands the waveform vertically by bringing the biggest peak to either +1 or −1. For example, for a square wave that has a minimum value of −0.5 and maximum of +0.7, the Normalise button will bring the 0.7 to 1 and the −0.5 will increase in amplitude by the same ratio.

More specifically, the ratio of the increase is 1/0.7 = 1.4286, so multiplying this by −0.5 gives −0.7143. Therefore the normalised waveform will range from −0.7143 to 1.
The image below shows the original waveform.

![Original Waveform](image1)

The image below shows after normalising the waveform.

![Normalized Waveform](image2)

18.1.9 Bit stream mode

In *Bit stream* mode you can define a pulse train in hex or binary, and set the logic levels.

![Bit Stream Settings](image3)
18.1.10 Number of samples
In the image above the pulses do not look very steep. This is because the number of samples is only 128. Increase this to produce better pulses. The maximum number of samples varies between products.
Preferences

The **Preferences** section allows you to set options for the PicoScope software. This can be accessed from the **Tools** menu by selecting **Preferences**:

The section is organized under tabs:

**19.1 General**

**19.1.1 Resetting**

The **Reset Preferences** button resets anything that has been changed in the preferences back to default settings.
19.1.2 Waveform buffer

By default this is set to 32, but it can be increased to be up to 10,000. The actual number of buffers may vary due to a number of factors; the device that is being used, whether the device is in Block or Streaming mode, the number of samples per buffer, and the type of triggering used.

Example

On a device in Block mode with external memory modules, the total number of buffers can be calculated approximately. For example, the PicoScope 3206B has 128 MS of memory. If PicoScope 6 is set to have a maximum of 32 buffers, each buffer must be no larger than 4 MS if all buffers are to be utilised. If the number of samples is increased further then the number of buffers will decrease.

In Streaming mode things get a little less straightforward. In PicoScope 6 the streaming rate is limited to 1 MS/s, or less with longer timebases. Since the device is streaming to the PC, the number of samples does not depend on the scope’s buffer size, so different rules apply. Using the 3206 as an example, at 10 s/div the device can stream at 1 MS/s, giving a total of 100 MS, so only 1 buffer can be used. If 2 s/div is chosen, this equates to 20 MS per buffer, but as 12 buffers can be collected this gives a total of 240 MS.

Collection time units

By default, the timebase of the scope is given in seconds per division. The total collection time, on the other hand, represents the time across the whole screen. For example, a 10 ms/div timebase when changed to total collection time would become 100 ms.
19.1.3 Measurement statistics

By default this is set at 20 and can be increased to 1000. These are the statistics over a number of captures that are presented when a measurement is added. The image below shows the min, max, average and standard deviation over 20 captures.

19.2 Power management

This control limits the speed at which PicoScope captures data from the scope. The other PicoScope settings, the type of scope and the speed of the computer will all affect whether this limit can actually be reached. PicoScope automatically selects the appropriate limit according to whether the computer is running on batteries or on mains (line) power.

The settings are in captures per second. By default, the capture rate is set to Unlimited when the computer is running on mains (line) power for maximum performance. If other applications run too slowly on the PC while PicoScope is capturing, then reduce the capture rate limit. When the computer is running on battery power, PicoScope imposes a performance limit to save the battery. This can be increased manually, but this will cause the battery power to drain very quickly.
19.3 Sampling

19.3.1 Adjusting waveform buffers.

19.3.2 Slow sampling transition

This alters the timebase at which the device changes from Block mode to Streaming mode. By default this is set at 200 ms/div.

There are two modes of operation: Block mode and Streaming mode. In Block mode the device captures data to the device’s memory and then transfers it to the PC, so the trace will appear on the screen once the buffer is complete. In Streaming mode the device can continuously stream data to the PC, so the trace will be drawn in real time. The timebase at which the device changes from Block mode to Streaming mode can be altered from 100 ms/div to 500 s/div.
19.3.3 Slow sampling display

This displays the previous buffer as the new one is being drawn. The image below gives a clearer view of this.

19.3.4 Sin(x)/x interpolation

PicoScope 6 uses sin(x)/x interpolation to draw the waveform on the screen. This means that fewer samples are required to draw a waveform accurately than with linear interpolation. A waveform using linear interpolation draws a line from one sample to the other, while sin(x)/x interpolation uses an algorithm that requires fewer samples to draw a waveform. To get a good representation of a signal when using linear interpolation, the sample rate has to be at least 5 or even 10 times higher than the highest frequency in the signal, while with sin(x)/x it only needs to be 2.5 times higher.
19.4 Colors

In this section the traces, background, masks and a number of other aspects of the software can be have the colour changed. The line thickness of the trace and the grid can also be altered. The example below shows the default colours changed to look like an old phosphor oscilloscope:
19.5 Keyboard shortcuts

PicoScope 6 now allows the use of shortcuts to the vast majority of the features. These can be accessed from the Preferences section under the Keyboard tab.

Sections where the shortcuts apply:

- AutoSetup
- Buffer
- Channel
- CollectionTime
- Config
- Copy
- File
- Instruments
- LoadFile
- Measurement
- Notes
- NumberOfSamples
- Persistence
- Persistence
- Print
- Run
- Settings
- Siggen
- Spectrum
- Tools
- Trigger
- View
The example below will be used to create a shortcut for the signal generator.

To assign a shortcut the desired action must first be selected. In the example below it is *Enabled.Set*, which enables the signal generator.
Then the **Assign** button is pressed and the shortcut can be typed in.

A total of 4 keys can be used including 3 modifiers (**Ctrl**, **Alt** and **Shift**) as the example below shows.

Click **OK** and these shortcuts can now be used.
19.5.1 Keyboard maps

A drop-down menu at the foot of the Keyboard dialog allows you to save and load collections of keyboard shortcuts called keyboard maps. Pico provides a number of standard maps, but you can also create your own:

To create your own map, change the keyboard shortcuts as explained above and then click Export. This creates a .pskeys file containing your settings. To retrieve these settings later, select Import from the drop-down list.
19.6  Regional & language

In this section the language of the software can be changed and metric or U.S. units can be selected. Simply select the language or units and click **OK**:

You will then be shown a prompt asking whether you want to restart the software now. Click **Yes** to automatically exit and restart the software with the language and units that have just been selected:
19.7 Options

In this section a number of advanced features can be hidden from view. The software can also be set up to remember the last device connected, so that next time PicoScope is loaded it will automatically search for the last device connected. This is particularly useful when multiple devices are connected:
The recent file list is the history of the files that have been opened. This can be modified to show up to 32 items. The image below shows 3 thumbnail views in the Recent Files list.

19.8 Printing
When printing a waveform some default text appears.
This can be modified by editing the appropriate fields:

File > Print Preview reveals the changed information:
20 The automotive software

The automotive software includes the same features as the test and measurement software, with some additional automotive-specific functions.

20.1 Automotive menu

The Automotive menu includes a number of tests that can be performed on the vehicle:

When you select an automotive test, a help file appears containing instructions and information for the test.

A saved example waveform is also shown. This will contain all the relevant settings to carry out your test, which includes correct timebase, voltage range, custom probe and triggering. You can then start the test by clicking Go and Stop.

The settings may need to be adjusted a little, as the waveform will vary depending on the vehicle, but they provide a good starting point.

The example below runs through a Primary Voltage Ignition test. First, select Ignition > Distributor > Primary Voltage from the Automotive menu:
The help file will appear with the relevant information and instructions.

Close or move the help file to view the example waveform, which shows the appropriate settings:

Check or uncheck the **Show Web Help** option in the **Automotive** menu to enable or disable the help file:
20.2 Waveform library

The waveform library is a major innovation in PicoScope that links your personal copy of the software to the community of PicoScope users around the world. To participate, all you need is an internet connection and an account on the picoauto.com forum.

Once you have these prerequisites, run PicoScope and go to File > Waveform Library. This opens the Waveform Library Browser. Log in with your forum credentials, and the browser will show a selection of waveforms from the library.

Use the data fields on the left to narrow down the selection to waveforms relevant to your diagnostic problem. If you find a waveform that you would like to display on your own PicoScope screen, click Open Waveform to load the file into PicoScope. This replaces all of your settings and waveforms with those from the library. Alternatively, click Load to copy the waveform to PicoScope as a reference waveform. Using this method, any waveforms that you have already captured remain on the display, with the library waveform displayed in a paler color.

If you wish, you can share the results of your investigation with the PicoScope community. This option is presented when you save the waveform using File > Save. Waveforms created by Pico Technology’s automotive specialists carry the “Verified by Pico Technology” mark.
20.3 Custom probes
The automotive software has a range of additional default custom probes available:

20.4 Hidden features
Some of the features available in the test and measurement software may be hidden here as they are not commonly used, for example Spectrum and Persistence modes. To enable these, select Preferences from the Tools menu:

Select the Options tab to see the advanced features that have been hidden. The image below shows that Spectrum, Persistence and some triggering options aren't selected:
Tick these boxes to re-enable the features:

The Triggering toolbar before and after enabling Spectrum and Persistence modes

The toolbars before and after enabling Spectrum and Persistence modes

20.5 Rotation rulers
The phase rulers mentioned earlier are called “rotation rulers” in the automotive version of PicoScope. They can be used to mark the four phases of a four-stroke engine. You can change the default 360 label on the second ruler to 720 to show the correct camshaft angle. To do this, double-click the “360” label and type “720”.

INDEX

Alarms, 76
Analog intensity mode, 92
Analog offset, 28
Arbitrary waveform generator (AWG), 90
Automotive help files, 174
Automotive menu, 173
Average math function), 135
AWG editor, 151
AWG, advanced, 149
Axis scaling, 26
Bandwidth limiter, 28
Bitstream AWG function, 157
Buffer navigation, 8
Channel options, 24
Channel selection, 4
Channels
  hiding, 42
Color preferences, 164
Copy to clipboard, 34
Coupling, 3
Custom probes, 44, 176
advanced, 99
Digital color mode, 92
Digital trigger, 131
Edge trigger, advanced, 121, 127
Edge trigger, simple, 126
Envelope math function, 135
Equivalent-time sampling (ETS), 118
Fast persistence, 92
File menu, 29
Filtering
  low-pass, 27
Frequency math function, 139
Function generator, 88
Interpolation, 163
Interval trigger, 123, 128
Keyboard shortcuts, 165
Language settings, 169
Layout, custom, 111
Level dropout trigger, 123, 128
Lissajous figures, 113
Logic trigger, 124, 130
Low-pass filtering, 27
Mask limit testing, 80
Masks, editing, 144
Math channels, 60
Measurements, 14
  number of captures, 161
Menu bar, 1
Notes box, 36
Offset, analog, 28
Peak math function, 135
Persistence mode, 91
Post-trigger delay, 117
Power management, 161
Preferences, resetting, 159
Print settings, 171
Printing, 31
Probes, 25
Properties window, 115
Pulse width trigger, 122, 127
Rapid block mode, 119
Recent file list, 171
Reference waveforms, 61
Resolution enhancement, 25
Rulers
  phase, 17
  rotation, 177
  time, 15
  voltage, 15
Runt trigger, 124, 129
Saving waveforms, 7, 29
Serial decoding, 68
Settings, 30
Signal view, 2
sin(x)/x interpolation, 163
Slow sampling transition, 162
Spectrum mode, 93
Spectrum window functions, 96
Starting and stopping, 4
Startup settings, 30
Timebase, 2
Toolbars, 1
Tools menu, 44
Trigger
  advanced edge, 121
Triggering, 5
  advanced, 120
Updates, checking for, 87
User's Guide, 86
Views, 37
  arranging, 110
  renaming, 109
Voltage range, 3
Waveform buffer size, 160
Waveform library, 175
Waveforms
  arranging, 41
Window dropout trigger, 124, 129
Window pulse-width trigger, 123, 128
Window trigger, 122, 127
XY mode, 113
Zooming and scrolling, 9